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Introduction
This handbook has been developed to guide assessors in writing reports for the Australian Aged Care
Quality Agency (Quality Agency).
The handbook covers requirements for different types of Quality Agency reports, with examples.
It is intended to be read in conjunction with the Assessor handbook, Results and processes guide,
Assessment modules and Style guide for assessors. These can be accessed from our website.
We have used the following symbols to point to further reading or resources:
indicates a cross-reference to another section of this handbook
indicates a reference to another document - such as the Assessor handbook
All assessors reporting on audits and assessment contacts are required to follow the guidelines in this
handbook. This is to ensure that reports are consistently produced according to Quality Agency and
legislation requirements.
It is not only our decision-makers and the approved providers of aged care who read our reports. In
thinking about the way reports are presented and the language they use, assessors need to bear in
mind that many people who read our reports are from outside the residential aged care industry - in
particular, people seeking a residential aged care home (or their relatives) may read a report on our
website to help decide which home to approach.
The guidance presented in this handbook is designed to help assessors to write with clarity and
structure so that readers can find the information they seek. If you are not sure how to present
information, please seek advice from your Assessment Manager or Group Leader.
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Section 1: Report types
1.1 Overview
There are five types of reports:
•

new home (commencing home) report

•

assessment contact report

•

statement of major findings (re-accreditation audits)

•

assessment information (re-accreditation audits and review audits)

•

audit report (re-accreditation audits and review audits).

The reports provide an important record of assessments and are a major input for our decisionmakers in evaluating homes' performance against the Accreditation Standards, making decisions
about their accreditation and identifying their individual case management needs. Reports also
inform future assessment teams.
Approved providers use our reports to assist them in determining actions that they may take to make
improvements. Your responsibility as the informed reporter is to document the outcome of each
assessment in accordance with our requirements as outlined in this handbook. Your findings about a
home's performance must be reported accurately, clearly and concisely.

1.2 New ('commencing') home report
In an accreditation application for a commencing home, the approved provider needs to show how
the home will meet the Accreditation Standards once it is operating and to give an undertaking that
the home will undertake continuous improvement across the Accreditation Standards.
When reviewing a new home's application, the assessment team considers:
•

the appropriateness and sustainability of the planned systems

•

the ease of transition from an empty building with no systems or staff

•

how the home will monitor whether it is meeting the needs and preferences of care recipients
as systems are adjusted when numbers increase.

The assessment and the decision to accredit a commencing home must be completed within 14 days
of receiving the application from the home.

1.3 Re-accreditation audits and review audits
Re-accreditation audits and review audits are comprehensive, on-site assessments of the quality of
care and services provided to care recipients by the home, measured against the Accreditation
Standards, and the reports required from both activities are similar.
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1.3.1 Assessment information
The assessment information report contains the assessment team's rationales for its findings about
the home's performance against all 44 expected outcomes. It includes specific information that
supports any finding that the home does not meet an expected outcome (supporting information). It
may also include suggestions for improvement.

1.3.2 Audit report
The audit report contains the assessment team's findings about the home's performance against all
44 expected outcomes and the rationales. Supporting information is not included in this report.
Section 3 describes these reports, particularly the requirements for rationales and supporting
information.

1.4 Assessment contact reports
An assessment contact will cover an assessment module, case-specific matters, or both.
The assignment request we send you specifies what is to be addressed at the assessment contact,
and we provide in your workpack either a template tailored to the assessment module or one that is
designed for assessment against expected outcomes only.
You already have separate templates for the audit trail and each expected outcome, which (where
necessary) you insert into the template provided in the workpack to compile the customised
assessment contact report.
Assessment contact reports are in the form of set statements - for example:
Care recipients/representatives expressed satisfaction with their medications.
The report template allows you to select yes, no, not considered or not applicable against the
statements.
See Section 4 for full details about assessment contact reports

1.5 Report templates
You must use the template that is provided in your workpack for each assignment -do not store old
templates or reports (apart from the expected outcome and audit trail templates that we provide for
insertion into an assessment contact report).
Not only is the template 'pre-populated' with details of the home, the approved provider and the
assessment team, it may be a different version with changes to content or formatting that we have
made since you last prepared a report.

1.6 A tip for ease of navigating around reports
Word has a 'document map' (Word 2003 and 2007) or 'navigation pane' (2010) which you can display
alongside your report. It will show you the major headings and you can click on a heading to jump to
that section of the report.
HDB_ACC_0019 v 14.0
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To turn it on (or off), go to the View menu and select Document Map or Navigation Pane.
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Section 2: Home details and audit trails
2.1 Home details
All report types contain basic details of the home and the approved provider. Most of the home
details section is automatically completed when the document is prepared for inclusion in your
workpack.
The assessment team leader needs to complete the details for:
•

number of care recipients during the assessment activity

•

number of care recipients classified as requiring high level care and services during the activity

•

special needs catered for (if applicable).

2.2 Audit trail
The audit trail is a record of the sources of information - in the form of interviews, documents and
observations - accessed by the team during the course of its assessment. There are four principal
sections in an audit trail:
•

interviews conducted

•

document types which were sampled

•

a list of all other documents reviewed, in alphabetical order

•

a list of key observations made by the team, in alphabetical order.

See page 10 for an example.
Names of care recipients and representatives interviewed are not used in the audit trail. If there have
been sufficient interviews so that individuals cannot be identified then care recipients and
representatives interviewed are to be counted separately, otherwise combine them.
Where possible the job titles of staff or others interviewed should be listed in the audit trail but if you
are asked to keep identifying information confidential you need to group them. For example, if there
is only one person working in maintenance and they request you do not identify them then list them
with other staff such as leisure and lifestyle staff under 'ancillary staff'.
It is important that items listed in the audit trail are directly related and of significance to the content
of the report. For example, if the team was examining medication management, relevant and
significant items may include storage of medication, medication round, medication charts, incident
reports and medication advisory committee minutes. It is not necessary to include 'micro items' such
as eye drops opened and labelled, disposable cups for medications, keys to medication trolley.
Do not include the dates of documents such as meeting minutes in the audit trail.
Avoid needless repetition such as an observation of "living environment" with separate listings of
"care recipient rooms", "dining room", etc. - living environment is usually sufficient.
HDB_ACC_0019 v 14.0
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The following should be used as a quick check when compiling an audit trail:
•

Are the lists of other documents reviewed and observations in the audit trail in alphabetical
order?

•

Can the audit trail be used to identify care recipients, representatives or any others
interviewed who requested their identity be kept confidential?

Audit trail
The assessment team spent 2 days on site and gathered information from the following:
Interviews

Number

Director of Nursing

1

Registered nurse

1

Care staff

3

Administration assistant

1

Catering staff

1

Care recipient / representatives

17

Volunteers

6

Laundry staff

1

Cleaning staff

1

Maintenance staff

1

Sampled documents

Number

Care recipient files

12

Care plans

12

Medication charts

9

Personnel files

6

Other documents reviewed
The team also reviewed:
•

Activity program

•

Care manual

•

Comments and complaints file

•

Communication and handover books
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•

Continuous improvement file

•

Emergency procedures manual

•

Job descriptions

•

Recruitment policies and procedures

•

Care recipients' information handbook

•

Care recipients' information package and surveys

•

Staff handbook

Observations
The team observed the following:
•

Activities in progress

•

Emergency exits and fire-fighting equipment, fire panel and location maps

•

Equipment and supply storage areas

•

Interactions between staff and care recipients

•

Living environment and gardens

•

Personal protective equipment

•

Storage of medications

•

Short group observation in the dementia specific unit

•

Suggestion box
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Section 3: Assessment information and audit reports (re-accreditation audits
and review audits)
Following a re-accreditation audit or review audit, the assessment team prepares the assessment
information which includes a rationale for its findings for each of the 44 expected outcomes and - if
the team has found the home does not meet the expected outcome - supporting information. It may
also include additional information.
The assessment information is given or sent to the approved provider, who has the opportunity to
respond before a decision is made.
The final audit report includes the rationale for each expected outcome, but not supporting or
additional information. This report is published on the Quality Agency website along with our
decision.
Assessment information
This section covers information about the home's performance against each of the expected
outcomes of the Accreditation Standards.
Standard 1 - Management systems, staffing and organisational development Principle: Within
the philosophy and level of care offered in the residential care service, management systems
are responsive to the needs of care recipients, their representatives, staff and stakeholders,
and the changing environment in which the service operates.
1.1 Continuous improvement
This expected outcome requires that the organisation actively pursues continuous
improvement".
Team's findings
The home meets this expected outcome / The home does not meet this expected outcome
Start rationale here (If pasting, please use EdittPaste Special\Unformatted Text)
Supporting information
•

Start supporting information here

Additional information
•

Start additional information here

1.2 Regulatory compliance
This expected outcome requires that the organisation's management has systems in place to
identify and ensure compliance with all relevant legislation, regulatory requirements,
professional standards and guidelines'.
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Team's findings
The home meets this expected outcome / The home does not meet this expected outcome
Start rationale here (If pasting, please use EditAPaste SpecialMJnformarted Text)
Supporting information
•

Start supporting information here

Additional information
•

Start additional information here

3.1 Rationales
A rationale presents the conclusions that are the reasons for the assessment team's finding about
whether the home meets the expected outcome or not.
Refer to the Assessor handbook - Section 7 Drawing conclusions about a home's performance

3.1.1 Requirements for rationales
Conclusions based on evidence
A rationale sets out the assessment team's conclusions based on the information collected during the
audit.
The Assessor handbook describes how the information relied on must be "competent, sufficient and
relevant" (page 7) and how conclusions must be "reasonable and objective" (page 64).
The decision-maker needs to be able to readily see the connection between the rationale and the
supporting information (see 3.2 on page 14) or additional information (see 3.3 on page 15),
Be precise: don't say "the home does not have a system" if your supporting information shows that
there is a system but it is not effective, or processes are not being followed, or it is not being
maintained through monitoring and evaluation.
The rationale should take into account information from interviews with care recipients and their
representatives, particularly when we have identified the focus of the expected outcome as 'results
for care recipients' (see the Results and processes guide). However, the individuals interviewed must
not be identified.
Directly address the expected outcome
It should be obvious to the reader that the rationale describes the home's performance in relation to
the specific expected outcome, in the context of the defining principle for its standard.
It is a good idea to make the first statement in the rationale an expression of your conclusion about
the home in terms of the outcome. For example: for 2.4 Clinical care - Care recipients receive
appropriate clinical care the opening statement might be:

HDB_ACC_0019 v 14.0
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Care recipients receive clinical care that is appropriate to their individual needs and
preferences.
One approach to writing a rationale is to present your conclusions about:
•

the home's system or processes (or lack of an effective system)

•

how the home monitors the effectiveness of its system or processes and what the results are

•

staff practice

•

the care recipient or representative view.

Example (the home meets expected outcome 2.4 Clinical care)
Type

Description

[How does the finding relate to the
expected outcome?] [The home's
system and/or processes]

Care recipients receive clinical care that is appropriate to their
individual needs and preferences. The home has an ongoing
review and evaluation system for identifying and managing
care recipients' health and personal care needs. Processes
include each care recipient having a health check, medical and
activities of daily living assessments on entry to the home. This
information is used to develop individual care plans. The home
monitors care recipients' clinical care outcomes through
reviews of care plans and internal audits of reporting
processes. Results show that care recipients' needs are
documented and reviewed, and that nursing and care staff
provide care consistent with documented care plans. Staff
practices are monitored for compliance with the home's
processes and procedures. In general, care recipients are
satisfied with the level of consultation and with the health and
personal care provided.

[How the home monitors the
effectiveness of its system or
processes]
[What are the results achieved?]
[What is the staff practice ?]
[What is the care recipient
/representative view?]

The Results and processes guide can assist in identifying the key aspects of each expected
outcome.
Refer to the Assessor handbook
–

Section 6.1.1 Confidentiality

–

Section 6.7 Corroboration

–

Section 7.2 Analysing the evidence

3.1.2 Clear and concise writing style
A rationale needs to be succinct, while adequately describing the reasons for the team's finding.
The primary readers of rationales are the Quality Agency decision-maker and the approved provider
or managers of the home. But audit reports are also published on our website, so it is especially
important to write rationales that consumers will understand - use plain language.
HDB_ACC_0019 v 14.0
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We prefer a rationale to be at least four sentences and no more than eight. Don't write long, complex
sentences - clarity will be lost; use more sentences to clearly say what needs to be said.
Note that rationales for 'universal outcomes' (continuous improvement, regulatory compliance,
education and staff development ) are lengthier, as they include details of activities and their results see Section 3.5 on page 18.
The Style guide for assessors has clear advice about the appropriate style for reports - in
particular:
–

Section 5 How do we present assessment reports?

–

Section 6 What is plain language?

3.2 Supporting information
Supporting information presents the facts that support the team's conclusions when the finding is
that the home does not meet an expected outcome. It is not required when the finding is that the
home meets the expected outcome.
Supporting information is not included in the final audit report which is published on our website.

3.2.1 Requirements for supporting information
Every piece of information must be relevant to your conclusions. Do not include information that
does not support the finding that the home does not meet the expected outcome: if there is
contradictory information, present it - with comments - under the heading of additional information
(see Section 3.3 on page 15).
If you are referring to information you have obtained through observation of a care recipient or from
a care plan, progress notes or other care documentation you should use the care recipient's name so
the information can be followed up by the approved provider and any issues raised can be resolved
to ensure care recipients receive better care and services. This information is already known to the
approved provider so there is no confidentiality issue, and it is not published.
Don't identify care recipients/representatives in relation to the information they have told you; and if
staff or others (e.g. a physiotherapist, hairdresser, medical practitioner, volunteer) request their
identity be kept confidential then do not link their name or position to the information.
Refer to the Assessor handbook Section 6.1.1 Confidentiality
Supporting information needs to describe:
•

What you saw: "A care recipient, Mary Baker was observed shaking the grill doors at the rear
of the unit, calling out 'let me out, I need to go home'. This occurred four times throughout a
one-hour period. We observed three care staff in the vicinity and none took any action. All
three care staff stated this is normal for her. We looked at the care plan and progress notes for
this care recipient. Strategies to help her settle were not documented. The calling out was not
noted."
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•

What you were told: "Nine of ten care recipients/relatives interviewed stated they were not
consulted regarding the lifestyle program." "Two staff said there is no time to consult with
individual care recipients."

•

What you read: "Seven of eight care plans did not contain information about individual
lifestyle assessment, lifestyle action plans and individual lifestyle programs. These care plans
were for the following care recipients: [list the care recipients]."

•

What the home's managers said in response: "Management said the care conference did not
always include lifestyle programs."

3.2.2 Organising supporting information
The information should be set out under headings that clearly relate to the conclusions presented in
the rationale rather than listed by the source of the information. Use bullet points to separate the
distinct facts you have gathered that lead you to conclude there is a deficiency or gap in the home's
systems, processes and/or practices.
The advantages of this for the decision-maker are that it will provide a clear connection to the
rationale and will demonstrate that your conclusions are based on information corroborated by more
than one source.

3.2.3 Writing style
Usually, the subject of the sentences you write will be the home, the care recipients, the staff,
management, the systems and processes, etc. When it is necessary to refer to yourselves do not say
"the [assessment] team", use the first person - "we" when there is more than one assessor, "I" when
there is only one of you.

3.3 Additional information
Additional information is not included in the final report that is published on our website.

3.3.1 When the home meets the expected outcome
Positive information
While you present positive conclusions in the rationale, additional information can be used to:
•

record improvements which the team believes have resolved a previous failure to meet the
expected outcome

•

give recognition to good programs or projects the home has undertaken.

Negative information
Negative information that may be set out in additional information includes:
•

contradictory information - explain the degree of weight placed on the information and how
the team concluded that the home meets the expected outcome
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•

concerns or areas for improvement which may at present only have a low or indirect impact on
care recipients

•

helpful information to support the home's continuous improvement

•

suggestions for possible improvements to systems.

It needs to be clear why the negative points have not caused the assessment team to consider that
the home does not meet the expected outcome.
When presenting negative information, include the response from the home's management.

3.3.2 When the home does not meet the expected outcome
Additional information may also be used alongside supporting information when the finding is that
the home does not meet the expected outcome, if the team wishes to record an aspect of the
home's practices that is working well in spite of the deficiencies found; offer suggestions; or
comment on contradictory information.

3.3.3 Suggestions
It is important that any suggestions made are not represented as required actions. Do not use the
words 'must' or 'should' when providing suggestions. More appropriate wording includes "we
suggested to the manager that the home could review ..." or "we discussed with the manager at the
home that advice on alternative activities may be sourced from ..." (Suggestions must have been
discussed during the visit before being included in the additional information.)

3.4 Examples
3.4.1 The home meets the expected outcome
This example presents additional information for a case where a home previously did not meet the
expected outcome but is now considered to have met the outcome. The first two dot points support
the finding that the failure to meet the expected outcome has been resolved. The last dot point
indicates a suggestion for the home.
Example:
2.8 Pain management
This expected outcome requires that "all care recipients are as free as possible from pain".
Team's finding
The home meets this expected outcome
Care recipients/representatives we interviewed reported that care recipients are as free as possible
from pain. They also described being consulted about pain management and offered a range of pain
management options. Qualified staff are trained in pain management and have access to a range of
pain management interventions. The home has a structured approach to identifying, assessing,
monitoring, referring and communicating care recipients' individual pain management needs. The
home is planning to introduce processes to improve identification of pain for care recipients with
HDB_ACC_0019 v 14.0
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cognitive deficits, or who do not speak English.
Additional information
•

The home has conducted a thorough review of its pain management program with
assessments having been conducted for all care recipients in consultation with care
recipients/representatives and their health care team. Care plans have been updated in
accordance with information gained through this process.

•

The home has established access to pain management specialists through a local area health
service.

•

Although staff confirmed a basic knowledge of communication processes, the home's
procedures do not contain clear guidance for managing and identifying pain where there are
communication barriers such as cognitive deficits. Nevertheless, all care
recipients/representatives indicated that their needs are being met. Management of the home
plan to review the home's policies and procedures in relation to the pain management of care
recipients with cognitive deficits.

3.4.2 The home does not meet the expected outcome
Example:
2.8 Pain management
This expected outcome requires that "all care recipients are as free as possible from pain".
Team's finding
The home does not meet this expected outcome
Care recipients/representatives we interviewed reported that care recipients' pain is not managed
effectively, that they often have to wait long periods for pain relief, and that interventions are
sometimes ineffective without follow-up action. The home does not have a system for identifying,
assessing, monitoring, referring and communicating care recipients' pain management needs, and
strategies for the management of pain are limited. Staff could not demonstrate an understanding of
each care recipient's pain management needs. The home's system for reviewing the appropriateness
of care recipients' pain management programs has not been maintained.
Supporting information
Care recipient feedback is negative
•

Nine out of 22 care recipients/representatives interviewed indicated the care recipient
experiences pain regularly, and that this is not managed effectively - for instance, all nine said
the care recipient is not asked if the intervention has been effective, and seven said that care
recipients often have to wait long periods of time for pain relief. Four representatives also
indicated the home does not assess and address the pain management needs of care
recipients with cognitive deficits.

There is no system for identifying, assessing and monitoring care recipients' pain management needs
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•

Progress note entries in five care recipients' files (Mary Baker, Iris Smith, George Jones, Doug
Millray, Maud Li and Glenda Brown) showed the care recipients regularly experience pain.
However:
–

Glenda Brown and Doug Millray's care plans did not indicate they experience pain

–

Mary Baker, Iris Smith and Maud Li's care plans had not been updated for seven months
(see expected outcome 2.4 Clinical care)

–

three files, for Doug Millray, Maud Li and Mary Baker, showed the intervention for
relieving the pain had not been effective

–

none of them had been referred to their medical officer or a specialist.

Staff understanding of pain management is limited
•

Mary Baker and Iris Smith in the dementia wing were observed grimacing and Iris Smith was
holding her stomach, hunched over. Care staff interviewed could not suggest possible causes
for this and no staff could describe how to identify pain in care recipients with cognitive
deficits or communication barriers. The home's policies and procedures do not include
information on pain identification and management for care recipients with cognitive deficits
or communication barriers.

•

Education records reviewed indicated that staff had not received education on pain
management for at least two years.

Strategies for pain management are limited
•

In all 16 files reviewed, the only pain management intervention recorded in progress notes and
care plans was pharmacological. Six care staff (including registered nurses) and management of
the home indicated the home does not offer other interventions and that pharmacological
interventions are often ineffective.

Monitoring of the pain system is ineffective
•

The Director of Nursing stated the home conducts annual audits of care recipients' pain
management programs. However, we noted the audit had not been completed for 18 months.
The Director of Nursing said this was because of a vacancy in the Deputy Director of Nursing
position and that the audit program would be reviewed and a pain management audit
immediately initiated.

Additional information
An exception to the home's ineffective management of care recipients' pain is that those receiving
palliative care have their pain managed well. Palliative care is provided in collaboration with a team
from the local hospital. We discussed with the manager at the home that she could consider
approaching the hospital team for advice on how the home might improve its pain management
system.
Notes on the example above:
•

The Director of Nursing did not request her identity be kept confidential.
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•

Additional information has been used to note a positive finding and the team's suggestion for
how this could be useful in planning improvements.

3.5 Presenting rationales for universal outcomes
Where there are common features to the home's processes for the related expected outcomes of
continuous improvement, regulatory compliance and education and staff development across all four
standards, it is acceptable to present a description of the home's overall process in Standard 1, and
refer to that under Standards 2, 3 and 4. That is:
•

Standard 1 has a complete rationale (plus any information specific to Standard 1)

•

Standards 2, 3 and 4 refer back to the rationale in Standard 1 along with a description of any
processes that are specific to the standard.

Rationales for the universal outcome continuous improvement should include examples of
improvement. This means they are part of the published audit report.
The examples should cover:
•

how the need for improvement was identified - for example, from care recipient or staff
feedback, or through the home's monitoring and review processes

•

what was done and how it addresses the problem

•

what are the results.

The following example illustrates this presentation for the continuous improvement outcomes (1.1,
2.1, 3.1 and 4.1).

Example:
1.1 Continuous improvement
This expected outcome requires that "the organisation actively pursues continuous improvement".
Team's finding
The home meets this expected outcome
The home has a continuous improvement system to identify improvement opportunities and monitor
performance against the Accreditation Standards. The home uses internal and external audits, care
recipient and staff surveys, service improvement reports, training and incident analysis to identify
improvements. Service improvement report forms are used by staff, care recipients and
representatives to make suggestions and to record any identified deficits in systems identified
through audits. The service improvement report forms are then actioned and analysed for trends
each month. Evaluations of improvements are conducted through gathering staff and care recipient
feedback, audits and monitoring incident data. Care recipients and staff are satisfied that the
organisation actively pursues continuous improvement.
Improvement initiatives implemented by the home over the last 12 months in relation to Standard 1
Management systems, staffing and organisational development include:
HDB_ACC_0019 v 14.0
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•

Management noted an increase in service improvement report forms received from some staff
about incidents and arguments with other staff members which was impacting on staff morale.
The director of care sourced an external provider to provide training to staff to discuss their
issues and negotiate some solutions. After the training the director of care noticed an
improvement in the morale of staff as well as a decrease in the number of service
improvement reports from staff about each other. Staff feedback was positive about the
training provided.

•

The organisation is in the process of implementing a new intranet system. Senior staff have
received training and a manual has been provided to assist them in accessing information such
as policies, procedures and frequently used forms. The new intranet also has a link to the
previous intranet for staff to use if required. This improvement is ongoing and is yet to be
evaluated.

2.1 Continuous improvement
This expected outcome requires that "the organisation actively pursues continuous improvement".
Team's finding
The home meets this expected outcome
Refer to expected outcome 1.1 Continuous improvement for information about the home's
continuous improvement systems and processes.
In relation to Standard 2 Health and personal care, staff record care recipient falls, skin tears,
medications, behaviours and unexplained absences of care recipients and this information is then
collated and analysed for trends. Care recipients and staff are satisfied that the organisation actively
promotes and improves care recipients' physical and mental health.
Examples of improvement initiatives related to health and personal care implemented by the home
over the last 12 months are:
•

A medication management audit identified the need to implement an imprest system stock of
antibiotics. The feasibility of this was investigated and this improvement was implemented.
Subsequent audits reflect an improvement in the home's medication management system.

•

Service improvement reports from staff identified the need for additional training and an
improvement in the information available in the home on peritoneal dialysis for staff. Training
was arranged for staff and a review of the procedures and guidelines available also occurred.
Staff feedback indicates they have found the additional training and resources beneficial.

3.1 continuous improvement
This expected outcome requires that "the organisation actively pursues continuous improvement".
Team's finding
The home meets this expected outcome
Refer to expected outcome 1.1 Continuous improvement for information about the home's
continuous improvement systems and processes.
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In relation to Standard 3 Care recipient lifestyle, care recipient meetings and care recipient surveys
are used to gather suggestions. Feedback is regularly recorded and evaluated from all lifestyle and
care activities. Staff also contribute to improvements to care recipient lifestyle through surveys,
training and networking. Staff encourage and support care recipients and others to provide feedback
and suggestions.
Examples of recent improvements undertaken or in progress in relation to Standard 3 Care recipient
lifestyle include:
•

As a result of care recipient feedback a new welcome pack has been introduced which has
been well received by new care recipients.

•

The activity program was reviewed in consultation with care recipients after some complaints
were recorded. Some of the changes made include a new exercise program, additional art
therapy and bingo sessions, and a men's group. Meeting minutes and care recipient feedback
indicate these changes have improved care recipient satisfaction with the activities program
and attendance records show an increase in participation.

•

The opening hours of the on-site café were expanded to include Sundays as a result of
requests from care recipients' families. Both care recipients and their representatives report a
high degree of satisfaction about the opening hours and services provided by the café.

4.1 Continuous improvement
This expected outcome requires that "the organisation actively pursues continuous improvement".
Team's finding
The home meets this expected outcome
Refer to expected outcome 1.1 Continuous improvement for information about the home's
continuous improvement systems and processes.
Examples of improvement initiatives implemented by the home over the last twelve months include:
•

As a result of feedback from care staff, the catering department developed and implemented a
one-page meal requirement sheet which provides care staff with clear information on care
recipients' meal needs. Care staff and care recipients report that meals are delivered more
quickly and accurately since the sheets were introduced.

•

The annual environmental security audit identified a need to upgrade the home's perimeter
security fencing system. Management decided to provide additional security via an array of
ultraviolet beams that are located around the inside of the fence. The installation of this
system is almost complete and final commissioning is expected after a period of testing. The
new system is expected to improve the safety of care recipients who try to abscond, and
reduce the threat of external intruders.
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Section 4: Assessment contact reports
4.1 Assessment contact report templates
The assignment request we send you specifies what is to be addressed at the assessment contact,
and in your workpack we provide either a template tailored to the assessment module or one that is
designed for assessment against expected outcomes only.
You already have separate templates for the audit trail and each expected outcome, which (where
necessary) you insert into the template provided in the workpack to compile the assessment contact
report. (Section 4.3 - page 26 - describes how to do this.)
Note that the templates are adaptable for a situation where the scope of the assessment changes
during the visit - for example, when assessing against an assessment module the team becomes
concerned that an expected outcome may not be being met and the Assessment Manager agrees
that the team should assess against that expected outcome. However, if the scope changes to a
different assessment module, the state office will need to send you a different report template.

4.2 The format of assessment contact reports
4.2.1 statements
The assessment contact reports are in the form of set statements.
For example:
Care recipients/representatives expressed satisfaction with their medications.
The statements are not intended to be used as a checklist; they do not drive the assessment process.
Rather, the assessment is carried out according to the assessment module, the Results and processes
guide and/or guidance given by the Assessment Manager, and the team then considers the
statements in the light of the information gathered.
Against each statement you may select:
Type

Description

Yes

when the statement describes what the assessment contact showed about
the home

No

when the statement does not describe what the assessment showed

Not considered

when:
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•

the scope of the visit is changed and therefore a module is not
completed

•

for some reason a statement cannot be verified due to a staff member
not being available

•

the team was instructed to focus on specific aspects of care or services
not relevant to this statement
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Note that some statements also have a 'not applicable' option, which can be used when the
circumstances described by the statement do not exist at the home. For example, a statement about
specialised nursing care has the 'not applicable' option for cases where the home has no care
recipients that require specialised nursing care.
Notes:
•

For a statement "Care recipients/representatives generally expressed satisfaction with ..."you
may select 'yes' when there is less than 100% satisfaction or care recipients have not
specifically said they are satisfied but on consideration of the information and impact to care
recipients you conclude that most care recipients were satisfied.

•

When a statement refers to more than one source of information or more than one
characteristic, only select 'yes' if they are all true - otherwise select 'no' or 'not considered' and
put an explanation in the explanatory notes. For example, for the statement "staff and
documentation confirmed.":
–

if staff confirmed the information but the documentation did not, select 'no'

–

if staff confirmed the information but documentation was not made available to the
assessment team, select 'not considered'

4.2.2 Explanatory notes
Space for explanatory notes is provided after the statements for an assessment module or an
expected outcome. Explanatory notes must always be completed when a statement has been
selected as 'no' or 'not considered'.
Do not repeat the statement in the explanatory notes. You may choose to refer to each statement
number or provide general facts covering a group of statements e.g. Statement 2.11, 2.13 to 2.17.
For 'no':
Please ensure that information provided as explanatory notes is limited to the facts, and any actions
and results of actions. Information should be concise. Include details of dates if necessary.
Example:
Statement 2.1 While eight care recipients/representatives expressed satisfaction with how
incidents are managed, two care recipients said they did not feel confident that some relief
staff would know what to do if they had a fall. We discussed this with the manager who said
they would ensure their relief staff receive falls and incident management training.
For 'not considered':
Do not state as an explanation that the team did not ask care recipients this statement or the
team was 'unable' to validate the statement.
 Do include information explaining why the statement has not been considered, for example, the
statements selected as not considered indicate the team pursued other enquiries.
For 'yes'
For statements selected as 'yes', explanatory notes are not mandatory; however, they can be used
to:
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•

report information related to specific areas for follow-up - for example, from referrals,
previous visits, or other case information received

•

record improvements made to systems which the team believes have resolved a previous
failure to meet the expected outcome

•

give recognition to good programs or projects the home has undertaken

•

identify areas for improvement which may at present only have a low or indirect impact on
care recipients, and/or any helpful information to support the home's continuous
improvement

•

raise concerns or suggest possible improvements to systems

Change of assessment contact scope
If the scope of the assessment contact was changed after consultation with the Assessment Manager
a brief explanation of the reasons should be included in explanatory notes.
Follow-up
Include in the explanatory notes any follow-up information that relates to a previous visit and applies
to the expected outcome or assessment module being assessed.

4.2.3 Expected outcomes: met or not met
The separate templates for each expected outcome that are inserted into the assessment contact
report have a 'Team's finding' drop-down, after the statements, where you select 'met' or 'not met'
for the finding about that expected outcome.
If you have found 'met' but there are a number of statements answered 'no', your explanatory notes
should make clear why you believe the home meets the expected outcome. The decision-maker and
the approved provider must be able to see why you have made the finding.

4.2.4 Continuous improvement
This refers to examples of continuous improvement the home identifies as being important - it is not
necessary to list all improvements made by or underway at the home, and it is not a requirement for
homes to have specific examples of improvement activities that relate to the module or the expected
outcome being assessed.
Activities that are to address a timetable for improvement should not be listed under continuous
improvement. Those activities are to be included in explanatory notes under 'Not met expected
outcomes assessed at this visit'.
If there has been a short period of time between visits and the home is continuing with the same
improvement activities, record the progress or the results of those activities.
When recording continuous improvement activities, consider:
•

the source of the improvement
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•

actions taken and/or implemented

•

results achieved for care recipients where applicable or results in general

•

the standard or standards that the continuous improvement activity may be linked to

Do not leave the continuous improvement section blank or type 'Not applicable'.
Continuous improvement examples
This:

Not this:
Following care recipient requests for
more physical activities, the home has
introduced a new walking group.
Attendance at the walking group has been
increasing and a care staff member has
been allocated to facilitate the
attendance of a care recipient with a
wheelchair. Care recipients said they
enjoyed the walking group.

The home has introduced a walking group
for care recipients that is held twice a week.

As a result of feedback from care
recipients and representatives and a
suggestion from a staff member, a new
lifestyle assessment form has been
introduced to improve the collection of
care recipients' cultural needs and
support information provided to staff. The
new form has been used for new care
recipients since June and it is expected
that all existing care recipients will be
reassessed by September. Management
have said that the assessments will be
used to develop new activities programs
and support care recipient cultural needs.

A revised lifestyle assessment has been
introduced to identify cultural needs and has
been in use since June.

Note that in the second example, the continuous improvement activity is still in progress. This activity
may be reviewed at a subsequent visit and the progress or results of the activity documented.

4.2.5 Other information to be considered
All the assessment contact report templates include an 'other information to be considered' section.
Use it to record:
•

information that may be outside of the scope of the assessment module or expected outcomes
assessed, such as positive or negative care recipient feedback. Please include facts about
actions taken by management in response to any issues you identify

•

changes to key personnel - this must also be included in the Assessment contact
recommendation form (see section 4.4 on page 29).

Example:
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The Director of Nursing informed us that the recent gastroenteritis outbreak did not result in
any care recipient admissions to hospital and that the home's outbreak management plan
has been updated. Only four care recipients in high care were affected. The infection control
officer has set up a new 'outbreak box' and we confirmed that procedures were followed
during the outbreak to minimise risk of infection spread. Staff education was also provided.
Three care recipients said that "staff were absolutely marvellous" during the gastro outbreak
and two representatives confirmed the outbreak was managed well.

4.3 Compiling and completing an assessment contact report
4.3.1 Responsibilities
The team leader is responsible for compiling and completing the 'master' assessment contact report.
During meetings held on site, the team leader should record how the team has agreed to answer the
statements. The team members need to identify any statements that they feel may not have been
adequately covered, so that more information may be gathered and the team can reach a consensus
before leaving the home.
The team also needs to agree on how they will provide their contributions to the assessment contact
report.
Sometimes an acceptable and workable approach is for the team member to type the information
they collected into an email to the team leader for copying and pasting into the master report. (Note:
this will require extra checking of the formatting before the report is submitted.)
Another way is for each assessor to use the template to prepare the sections of the report they have
been assigned responsibility for and email it to the team leader, who can then compare the
documents side by side and copy information into the master report.

4.3.2 Compiling an assessment contact report
Audit trail
All assessors have been provided with the audit trail template as a separate document (.dot file
extension) to the assessment contact report. The details need to be completed and finalised before it
is inserted into the master assessment contact report.
For best results, each team member should complete the audit trail as a separate document, save the
document as "Audit trail [Home name, RAC ID and assessor initials]" and email the completed audit
trail to the team leader. This will allow the team leader to copy and paste information into their
'master' audit trail, sort and check the audit trail before inserting it into the master assessment
contact report. Changes may still be made to the audit trail once it has been inserted into the
assessment contact report, but the sort function is not available.


The team leader inserts the audit trail into the 'master' assessment contact report template
after it has been completed and sorted.



Do not copy and paste the full audit trail document into the assessment contact report as this
will affect the format of the report.
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Please refer to the appendix - Word hints and tips - for instructions on:
–

inserting a file

–

comparing documents side by side

–

copying and pasting information in tables

Not met expected outcomes considered at this visit
The template always includes this section when any expected outcomes identified as not met at a
previous visit remain to be addressed.
If this section does not apply (i.e. all expected outcomes were met at the last visit), delete the
header, instruction text and all principles for each standard.
Otherwise:
1.

Identify any standards for which all expected outcomes were met at the last visit and delete
the standard, the principle and the instructions.

2.

Where an expected outcome was not met at the last visit, insert the applicable file from the
suite of .dot files that have been provided separately (e.g. EO 1_8 vX.X Statements - ACR.dot)
under its standard.

3.

For each expected outcome that you have inserted:
under Explanatory notes, delete the section 'Facts for a new not met expected outcome" .

Expected outcomes assessed at this visit
The template always includes this section where any expected outcomes that you have been asked
to assess against - either in the assignment request or when the Assessment Manager has changed
the scope - are to be included.
If this section does not apply (i.e. the scope was only an assessment module) delete the header,
instruction text and all principles for each standard.
Otherwise:
1.

Identify the standards where there are no expected outcomes included in this assessment
contact and delete the standard, the principle and the instructions.

2.

For the remaining standards, insert the expected outcome file(s) from the suite of .dot files
that have been provided separately (e.g. EO 1_8 vX.X Statements - ACR.dot).

3.

For each expected outcome that you have inserted: under Explanatory notes, delete the
section that does not apply.

4.3.3 Completing an assessment contact report
Home details
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All text fields in this section that are in black and with brackets [ ] are merge fields. These are
automatically merged from our data management system. If during the visit, the home informs the
team leader that the home details are incorrect, for example, telephone number or email address,
this must be recorded on the Assessment contact recommendation form - see Section 4.4.
The assessor who is responsible for the master assessment contact report (usually the team leader)
types all areas in blue text into the report. This includes:
•

Person in charge on the day

•

Number of care recipients during assessment contact

•

Number of care recipients classified as requiring high level care and services during the activity

•

Other special needs, if any
Include any special needs that the home caters for and is important to the home but is not
defined as a special needs group - for example, the home may have a number of young care
recipients.

•

Time visit commenced

•

Time visit finished

•

Total assessor hours worked on site
Total assessor hours are calculated as total hours on site, less the half hour meal break, to the
nearest half hour.
If there are two assessors or more, this is the total hours on site, less the half hour meal break,
multiplied by the total number of assessors.
For example:
Two assessors on the team
Total hours on site = 7 hours
Less half hour for lunch = 6.5 hours
Total assessor hours worked on site = 13 hours
The team leader will type in this field '13 hours'

All blue text is to be converted to black once data entry has been completed.


Select only the blue text and convert the font colour to black.



Do not select all text in the document or highlight the full page to convert text to black font
colour as this will affect the headings as well.
Please refer to the appendix - Word hints and tips - for instructions on:
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–

text entry fields

–

converting blue text to black

Audit trail
See section 2.2 for the requirements for audit trails.
Not met expected outcomes considered at this visit (if applicable)
For each expected outcome:
1.

Select yes, no, not considered or not applicable against the statements (see section 4.2.1).

2.

Choose 'met' or 'not met' for the team's finding against the expected outcome.

3.

Complete the explanatory notes as applicable (see section 4.2.2).

Continuous improvement (always)
See section 4.2.4
Assessment module (if applicable)
1.

Select yes, no, not considered or not applicable against the statements (see section 4.2.1).

2.

Complete the explanatory notes (see section 4.2.2).

Expected outcomes assessed at this visit (if applicable)
For each expected outcome:
1.

Select yes, no, not considered or not applicable against the statements (see section 4.2.1).

2.

Choose 'met' or 'not met' for the team's finding against the expected outcome.

3.

Complete the explanatory notes as applicable.

Other information to be considered
Refer to section 4.2.5 for how to use this space.

4.4 Assessment contact recommendation
The assessment contact recommendation is a separate form that is used for administrative purposes.
It is not given to the approved provider.
There is provision in the template for the team to identify any matters that it recommends be
followed up at the next visit.
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Section 5: Submitting reports
5.1 Submission deadlines
The timeframe for submission of a report is stated on your assignment request. When the team finds
a failure to meet the Accreditation Standards we require the report to be submitted earlier.
•

An assessment contact report is due within 24 hours of the exit meeting if any expected
outcomes are not met, otherwise within five days.

•

Re-accreditation audit assessment information:
–

if the team has found the home meets less than 44 expected outcomes, this report is to
be submitted as a matter of urgency, preferably within 24 hours of the exit meeting; the
team leader should discuss the timeframe with their Assessment Manager or Group
Leader

–

if the home meets all 44 expected outcomes the report is due within five business days.

•

A re-accreditation audit report is due within 14 days of the exit meeting.

•

The review audit assessment information is given to the approved provider's delegate at the
exit meeting and must be submitted to your state office within one day.

•

A review audit report is due to be submitted within five days of the exit meeting.

5.2 Final checks
Before submitting a report or giving it to the approved provider, the assessment team must complete
a final review - proofread, edit and format. Make sure that:
•

the audit trail is complete and in alphabetical order

•

for audit assessment information, every expected outcome has a finding, a rationale and,
where the home does not meet the expected outcome, supporting information

•

no negative findings have been included that you did not mention to the approved provider's
delegate during the visit (unless you have discussed this with the Assessment Manager and
informed the approved provider)

•

the report has been checked for spelling and the formatting follows the 'house style'.
See the Style guide for assessors, Section 4 How do we format our documents?
See the appendix - Word hints and tips - for instructions on using the "ACSAA reporting
toolbar"
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5.3 Team endorsement
Each team member must review the report and email the team leader confirming that they accept it
as the record of the assessment activity.

5.4 Reporting administrative and logistical information about a home
There are a number of administrative and logistical details which need to be communicated to us as a
result of site visits. For example:
•

key personnel changes

•

additional beds approved and date of effect

•

progress in implementing additional beds

•

imminent sale of the home

•

planned building upgrades

•

home or approved provider details that have changed.

These should be reported by email to the Assessment Manager and recorded in the Assessment
contact recommendation at the end of each visit.

5.5 Electronic documents
The team leader's covering email needs to:
•

include the home's name, RACS ID and type of visit in the subject heading

•

state that all team members have endorsed the report

•

notify any findings of failure to meet the Accreditation Standards.

For final audit reports, if the team has made changes to any of the rationales so that the report is
different to the assessment information, this must be stated in the covering email.
Use the following email addresses:
Adelaide office: sa_nt@aacqa.gov.au
Brisbane office: qld.statemanager@aacqa.gov.au
Melbourne office: vicqareports@aacqa.gov.au
Perth office: wa@aacqu.gov.au
Sydney office: decisionandcompliance@aacqa.gov.au.
We store the email in our IT system as a permanent record.
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5.6 Hardcopy documents
Hardcopy documents are to be either hand-delivered or posted, using the 'poly tough' bag we
provide.
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Appendix: Word hints and tips
1. Undo
In any situation, you may use the 'undo' button

or shortcut Ctrl+z.

2. Converting blue text to black
All instruction text is in blue font. Once all typing has been completed, convert blue font to black
font.
Note: in assessment contact reports DO NOT use select all (Ctrl+a) to convert text to black, as this will
change text that needs to be left in the original formatting, such as headings.
Step 1 Highlight the blue text only and from the top menu bar, select the drop-down on the symbol
(font colour).
If the symbol is not displayed on your menu bar, please use the help menu and search for
'font colour'.
Step 2 Select 'Automatic' from the drop-down to convert the selected text to black.

3. Assessment contact report text entry fields
Fields with text in inverted commas - for example "insert first name and surname here e.g. Jo Smith"
- are 'click and type' fields. To type text:
Step 1 click anywhere on the text - the text field will darken as shown below:

Step 2 type over the highlighted text (do not delete it - as soon as you start typing the existing text
will be overwritten).

4. Assessment contact report: inserting a file (document)
The following instructions refer to Word 2003.
For Word 2007 and 2010 users, see page 34 for where to locate the insert function.
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Apple users: Alternative instructions are available on request. Please email feedback@aacqa.gov.au.
To insert a file:
Step 1 click on the line "Click here and insert file..."

Step 2 go to the Insert menu and select File. Word displays the Insert File window for you for you to
browse for the location where you have saved your audit trail and expected outcome files use the Look in field.
Note: if you cannot see the files, change the Files of type field by selecting <All files (*.*)>
from the drop-down menu. The files for insertion have been sent to assessors as document
templates (.dot file extension). This format ensures that the insert files are not accidentally
overwritten.

Step 3 double-click to select the file for insertion. The entire document will be inserted under the
heading.
Step 4 delete any blue instruction text that is not required after inserting - e.g.
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Note: ensure the Audit trail document has been completed and sorted into alphabetical
order prior to inserting.
Microsoft word 2007 and 2010
For users of newer versions of Microsoft word (2007 and 2010), the Insert File function is found
under Insert > Object > Text from file.
Step 1 click on the line "Click here and insert file..."
Step 2 on the top menu bar, select the Insert tab
Step 3 click the Object drop-down and select Text from file

Step 4 Word displays the Insert File window for you to browse for the location where you have
saved your audit trail and expected outcome files. Select the document and double-click to
insert it.
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5. Copying and pasting information in tables
When consolidating audit trails, you may need to copy and paste information from one table to
another.
Take care when copying cells and ensure you are only copying the text: it is best to highlight the
words only by clicking just before the first letter and dragging to the end letter. Do not highlight the
whole row (as is described below in Deleting table rows) as this may change the formatting of your
table.

6. Deleting table rows
Step 1 To select a row move your mouse to the far left hand side of the row, just outside the table
area and click-the row will be highlighted. Drag the mouse if you want to select multiple
rows.

Step 2 To delete, go to the Table menu, select Delete then Rows.

7. Adding rows to tables
To add additional rows one at a time, use either of the following methods.
•

Go to the Table menu and select Insert then Rows Above or Rows Below.

or
•

Move your mouse to the far right hand side of the row - just outside the table, and click. The
cursor mark will be outside the row, and press enter to insert a row below the selected row.

8. Assessment contact reports: comparing documents side by side
Note: you have to open both documents before comparing. There is no need to minimise them.
Step 1 Open each document - e.g. the team member's document and then the master template.
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Step 2 While in the master template, go to the Window menu and select Compare Side by Side
with...
If you only have the two documents open, Word will automatically identify the other file to
be compared. Otherwise, you need to select the file from a list.

The two documents will be displayed side by side and will scroll through together.

Click the Synchronous Scrolling button
independently.

to scroll through the documents

9. Turning on/off the paragraph marks
Paragraph marks are turned on if you see the paragraph symbol (¶) displayed in the document and
the Show/Hide ¶ button is highlighted in the toolbar:

Click on the button in the top menu bar to turn the paragraph marks on (show) or off (hide).
Note: when the paragraph marks are shown you will also see section breaks and these may affect the
way the document appears on screen.

10. Using the "ACSAA reporting toolbar" (audit assessment information and
reports)

The "ACSAA reporting toolbar" has been set up to make it easy to format reports according to the
Quality Agency's style.
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Once the toolbar is activated, clicking on a button will format the text where your cursor is:
T Normal is for body text in rationales, supporting information and additional information
Bullet 1 is for a first-level bullet (dot point)
Bullet 2 is for a second-level, indented bullet
Paste text is for use when you have copied text from elsewhere: use this button instead of Ctrl+v or
Edit > Paste to avoid importing unwanted formatting into the report.
To enable the macro that activates the toolbar, you first need to set your security level to medium:
Step 1 Go to the Tools menu and select Macro then Security. Word displays the Security window.

Step 2 Click the Medium button and then OK.
Step 3 Close Word. When you open Word again it will display a Security Warning. Click Enable
Macros to proceed

Note: the security warning will be displayed each time you open a Word document that contains
macros.
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